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Preparation on the PC 

• Install the software 

http://www.autoelectric.cn/MiniPro/minipro_setup.rar?Lastvesion660 

Latest version 20-Aug-2017 is version 6.60  (版本: V6.60 支持芯片数:14177 --2017.05.09) 

(main website: http://www.autoelectric.cn/TL866_main.html) 

• Connect the MiniPro TL866A with the USB cable to the PC 

 

 
 

The tool will automatically indicate if a Reflash of Firmware need to be done. 

 
 

  

http://www.autoelectric.cn/MiniPro/minipro_setup.rar?Lastvesion660
http://www.autoelectric.cn/TL866_main.html


• Once opened.  Tools > Reflash Firmware 

 

 
 

• Press Reflash 

 

 

 



• (I closed the Software) and restarted it again. It will not ask anymore the Reflash the firmware 

 

  



Part 1 – Programming the ATMEGA1248P Chip 

• Note: if you want to burn the “Rasmus 8-in-1.bin” file, then Part 1 is not needed as this image 

does not need the ATMEGA1248P on the UberGrom cart to run! It only needs the AT49F040 

and go directly to Part 2). 

• And similar for other .bin files  (I tested the EducartsRom.bin it does not need the 

ATMEGA1248P Chip: 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=4

16108 

 

• Now insert the ATMEGA1248P Chip into the socket of the TL866A and close the socket so that 

the chip does not move. Make sure that the Chip is inserted correctly into the right direction 

(see the indicator on the MiniPro). 

•  

The AVR we use is: http://www.atmel.com/images/doc8059.pdf 

8-bit Microcontroller with 128K Bytes In-System Programmable Flash ATmega1284P (ATMEL) 

 
 
Source: https://en.wikipedia.org/wiki/Atmel_AVR 
AVR stands for Alf and Vegard's RISC processor 

Atmel AVR: 
AVR is a family of microcontrollers developed by Atmel beginning in 1996. These 
are modified Harvard architecture 8-bit RISC single-chip microcontrollers. AVR was one of 
the first microcontroller families to use on-chip flash memory for program storage, as 
opposed to one-time programmable ROM, EPROM, or EEPROM used by other 
microcontrollers at the time. 

 

 

The following instructions come from the Great Gazoo .pdf document 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=415771 

(MiniPro-programmer-1284p-GAZOO.pdf) 

• Search for ATMEGA1248P 

• Select Config 

• Uncheck the V ticks  

• The screen should look like this. Check also all other options  

(as maybe in future versions there could be additional parameters) 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=416108
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=416108
http://www.atmel.com/images/doc8059.pdf
https://en.wikipedia.org/wiki/Atmel_AVR
https://en.wikipedia.org/wiki/Microcontroller
https://en.wikipedia.org/wiki/Atmel
https://en.wikipedia.org/wiki/Modified_Harvard_architecture
https://en.wikipedia.org/wiki/8-bit
https://en.wikipedia.org/wiki/Reduced_instruction_set_computer
https://en.wikipedia.org/wiki/Flash_memory
https://en.wikipedia.org/wiki/Programmable_read-only_memory
https://en.wikipedia.org/wiki/EPROM
https://en.wikipedia.org/wiki/EEPROM
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=415771


 

  



• Click Device > Program 

 

 

• Uncheck “Code Memory” 

• Uncheck First Read RC Calibration for User’s DLL 

• Uncheck DATA Memory 

• Check Con.FUSE Bit  

• Check LOCK Bit 

 

 



• Then Click Program 

 

 

• Press Cancel (to go back to the main screen) 

 

• Select the Config Tab 

 

• Enable the parameters as shown below 

 

• (More explanation about “Fuses” are here: http://atariage.com/forums/topic/244707-

preparing-an-avr-as-an-ubergrom/ 

 

o First Column 

▪ SUT1=0 

▪ SUT0=0 

▪ CKSEL3=0 

▪ CKSEL2=0 

▪ CKSEL0=0 

 

o Second Column 

▪ SPIEN=0 

▪ BOOTSZ1=0 

▪ BOOTSZ0=0 

▪ BOOTRST=0 

 

o Third Column 

http://atariage.com/forums/topic/244707-preparing-an-avr-as-an-ubergrom/
http://atariage.com/forums/topic/244707-preparing-an-avr-as-an-ubergrom/


▪ BODLEVEL0=0 

 

• Click the Code Memory button 



 

 

 

  



• Click the file tab and open to load the 128k flash file (must be a .bin file). 

• I used the 128K.bin file from the ExBas 2.7 Suite  (“XBv27 060315.zip”) 

• Source: 

http://atariage.com/forums/topic/229718-extended-basic-v27-suite-cartridge/page-21 

Direct link to .zip file: 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_rel_

module=post&attach_id=394788 

• Extract the .zip file: XBv27 060315.zip 

and go to the subdirectory to find “XB27 Suite 128k Flash 060315.bin” 

 

 

 

 

• File > Open  “XB27 Suite 128k Flash 060315.bin” 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_rel_module=post&attach_id=394788
http://atariage.com/forums/topic/229718-extended-basic-v27-suite-cartridge/page-21
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_rel_module=post&attach_id=394788
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_rel_module=post&attach_id=394788
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_rel_module=post&attach_id=394788


 

  



• Click the data memo tab and then click the file tab and open to load the EEprom file 

(must be a .bin file). 

 

 
 

 



 

 

 

  



• File > Open “XB27 Suite EEprom 060315.bin” 

 
 

• Click “Device > Program 

 
 

  



• Select all the Parameters 

 
 

• Click Program and wait until “Programming Successful” 

(note that Gazoo’s document mentioned: You will get an error when it programs the fuses 

(the last part), but it will have successfully programmed them). But with this version 6.60 

software and TL866A version everything is okay. 

 

 

 



• Click Cancel 

• Close the program  

• And remove the ATMEGA1248P from the MiniPro 

• Insert the ATMEGA1248P into the UberGrom Cart 

 

 
 

 



More information about the ATMEGA1248P AVR 

http://atariage.com/forums/topic/249396-ubergrom-mini-avr/page-1#entry3446429 

  

http://atariage.com/forums/topic/249396-ubergrom-mini-avr/page-1#entry3446429


Part 2 – Programming the AT49F040 Chip using the MiniPro and PLCC32 ZIF  

(Zero Insertion Force) Socket Adapter 

 

I am using the “AT49F040-90JC”  AT49F040 version (without T) 
http://pdf.datasheetcatalog.com/datasheets/270/132294_DS.pdf 

 

 
4-Megabit, (512K x 8) 5-volt Only CMOS Flash Memory AT49F040, AT49F040T, AT49F040/040T 

 

 
 

 

• Insert the PLCC 32 ZIF adapter with PIN 1 and PIN 32 (and the hole indicator) at the 

correct position in the MiniPro 

 

 
 

  

Pin 1 and 32 at this side 

http://www.datasheetcatalog.com/datasheets_pdf/A/T/4/9/AT49F040-90JC.shtml
http://pdf.datasheetcatalog.com/datasheets/270/132294_DS.pdf


   
 

• Insert the AT49F040 into the PLCC32 and lock/secure it properly 

 

• (Background information 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach

_id=483532) 

  

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=483532
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=483532


• Select the right chip and socket 

In my case ATMEL - AT49F040 and @PLCC32 

 

 

 



• Press the ID Icon 

(it will show the ChipID information, in my case 1F 13) 

 

 
 

 

  



• File open 

• Select the “512K Rom file” (we used the one from the ExBas Suite, see Part 1) 

 

• Extended Basic Fun  (Exbas 2.7 + XB256 + TML) 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach

_id=387341 “Extended Basic Fun.zip“ 

• http://atariage.com/forums/topic/223979-setting-up-a-632k-cart/page-6#entry3217247 

 

 

 

Note: Here are many more images 

o http://atariage.com/forums/blog/567/entry-12468-bin-repository-backup-extra-

stuff-updated-030916/ 

o http://atariage.com/forums/topic/243766-bin-repository-images-for-burning-

cartridges-5142017/page-2#entry3347254 

 

 

 
• A new window will pop-up 

 

 
 

 
 

 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=387341
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=387341
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=387341
http://atariage.com/forums/topic/223979-setting-up-a-632k-cart/page-6#entry3217247
http://atariage.com/forums/blog/567/entry-12468-bin-repository-backup-extra-stuff-updated-030916/
http://atariage.com/forums/blog/567/entry-12468-bin-repository-backup-extra-stuff-updated-030916/
http://atariage.com/forums/topic/243766-bin-repository-images-for-burning-cartridges-5142017/page-2#entry3347254
http://atariage.com/forums/topic/243766-bin-repository-images-for-burning-cartridges-5142017/page-2#entry3347254


Device > Program 

 
 

• Click Program 

 

 
 

 



 
 

• Cancel 

 

 



• Quit the program 

 

• Open the PLCC32 holder and Remove the AT49F04 Chip  

 

• Insert the AT49F04 Chipinto the UberGrom Cart 

 

  



Extended Basic 2.7 Suite with Speech Synthesizer 

saying “Texas Instruments Home Computer” at the startup screen 

 
(the latest version I “XBN v27 suite 061315.zip” 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=396

166 

and the latest (to use via disk upgrade / Grom Loader is  

• XB27SPEECH.dsk   180KB    http://atariage.com/forums/index.php?app=core&modul

e=attach&section=attach&attach_id=398747 

• 060715XB27.dsk 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach

_id=398748 

 

 
 

 

Upgrading the Extended Basic Suite 2.7 

 

• http://atariage.com/forums/topic/237401-xb27s-cartridge-boot-return-interception-

utility/?p=3225086 

http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=396166
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=396166
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=396166
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=398747
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=398747
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=398747
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=398748
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=398748
http://atariage.com/forums/index.php?app=core&module=attach&section=attach&attach_id=398748
http://atariage.com/forums/topic/237401-xb27s-cartridge-boot-return-interception-utility/?p=3225086
http://atariage.com/forums/topic/237401-xb27s-cartridge-boot-return-interception-utility/?p=3225086


• http://atariage.com/forums/topic/229718-extended-basic-v27-suite-cartridge/page-

10#entry3206707 

• http://atariage.com/forums/blog/567/entry-11327-extended-basic-v27-suite-final-update-

9272015/?st=20#commentsStart 

• http://atariage.com/forums/blog/567/entry-12468-bin-repository-backup-extra-stuff-

updated-030916/ 

 

 

• ATMEGA1248P  

o For Code Memory startup 128k Flash.bin 

o  

 
 

 

• For  

 
 

http://atariage.com/forums/topic/229718-extended-basic-v27-suite-cartridge/page-10#entry3206707
http://atariage.com/forums/topic/229718-extended-basic-v27-suite-cartridge/page-10#entry3206707
http://atariage.com/forums/blog/567/entry-11327-extended-basic-v27-suite-final-update-9272015/?st=20#commentsStart
http://atariage.com/forums/blog/567/entry-11327-extended-basic-v27-suite-final-update-9272015/?st=20#commentsStart
http://atariage.com/forums/blog/567/entry-12468-bin-repository-backup-extra-stuff-updated-030916/
http://atariage.com/forums/blog/567/entry-12468-bin-repository-backup-extra-stuff-updated-030916/


 
 

 



 
 

 

1. Use the XB27 Suite with 32K  (press F7) 

a. e.g. with a nanoPEB (with CF card) 

b. or normal PEB + 32K + diskdrives 

 

2. Press F6 to do verification (FCTN-6) 



 
 

3. Press F7 for version (FCTN-7) 

 



 
 

4.  Press F5 for Ernie and Bert  (FCTN-5) 

 



 
 

 

 



 

 

Using nano-PEB 

 

1. Goto to Extended Basic  (e.g. keep pressing “A” until you see the prompt) 

 

2. (for nano-PEB).  CALL MOUNT(1,3), which means that DSK1 will be the  

XB27SPEECH disk (as it is VOL #0003) 

 

3. Press FCTN-=  (QUIT) 

 

4. Now load Extended Basic again, press A 

 

5. Automatically GROMLOADer is loaded 

 

 
 

  



6. Enter DSK1.XB27SPEECH 

 
 

7. Now it is reading GROM A,  B,  C, etc.  until O  and EEPROM P 



 
 



 
8. Wait until you see Successful 

 

9. After this press “Space” and a reset is automatically done 

 

10. Now you will hear XB 2.7 Suite saying, “Texas Instruments Home Computer” 

(you need to have the Speech Synthesizer connected and 32K) 

 

 

  



Rasmus 8-in-1 cart  inserted! 

It runs without the ATMEGA1248P chip  (but you can run with it as long you only 

load the 128K flash Startup file and not the EEPROM file (e.g. not the XB2.7 

EEPROM file as it confuses the TI Program list 

 

http://atariage.com/forums/topic/243766-bin-repository-images-for-burning-cartridges-

5142017/page-3#entry3358452 

 

 
 

Here is a 8-in-1 cartridge image with all my games together. It requires a 512K red 

board or a blue board without any GROMs loaded to run.  
  

Rasmus 

8-in-1 

http://atariage.com/forums/topic/243766-bin-repository-images-for-burning-cartridges-5142017/page-3#entry3358452
http://atariage.com/forums/topic/243766-bin-repository-images-for-burning-cartridges-5142017/page-3#entry3358452


 
  
The games have been reassembled to ensure that you can soft reset (Fctn-quit) - at 
least from the title page - and that the F18A is properly reset/locked, which was 

causing problems on the old 3-in-1 cart. 
  
The reason you cannot run the image on a blue board with any GROMs loaded is that all 

the entries in the menu are in use, and if you add another entry it starts to misbehave. 
I have tried it on a blue board with the ATMega 1284 removed, but I don't have a red 
board to test it with yet. 
  
I have included the latest version of Bouncy on the image (the one with a bigger score range), but 
since this game is still in the test phase it is likely that I will update the image with a newer version 
later on. 
  

http://atariage.com/forums/uploads/monthly_11_2015/post-35226-0-90041800-1446494478.png


EducartsRom.bin  

It runs without the ATMEGA1248P chip (but you can run with it as long you only 

load the 128K flash Startup file and not the EEPROM file (e.g. not the XB2.7 

EEPROM file as it confuses the TI Program list 

 

Other useful AtariAge resources 

http://atariage.com/forums/topic/230688-tl866cs-minipro-eprommer/ 

http://atariage.com/forums/blog/567/entry-12391-making-ones-own-cartridges-edited-12072015/ 

http://atariage.com/forums/topic/244707-preparing-an-avr-as-an-ubergrom/ 

http://www.harmlesslion.com/cgi-bin/showprog.cgi?search=grom 

http://atariage.com/forums/topic/250878-snake-plissken-game-in-development/?p=3483459 

http://atariage.com/forums/topic/250878-snake-plissken-game-in-development/?p=3483998 
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